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Technical Support
If you have difficulties using Disketch Disc Label Software please read the applicable topic 
before requesting support. If your problem is not covered in this user guide please view the 
up-to-date Disketch Disc Label Software Online Technical Support at 

www.nchsoftware.com/cdlabeler/support.html. 
If that does not solve your problem, you can contact us using the technical support contacts 
listed on that page.

Software Suggestions
If you have any suggestions for improvements to Disketch Disc Label Software, or suggestions 
for other related software that you might need, please post it on our Suggestions page at 

www.nch.com.au/suggestions/index.html. 
Many of our software projects have been undertaken after suggestions from users like you. 
You get a free upgrade if we follow your suggestion.

www.nchsoftware.com/cdlabeler/support.html
www.nch.com.au/suggestions/index.html
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Overview
Thank you for installing Disketch Disc Label Software Disc Labeler. Use Disketch to 
personalize your CD, DVD and Blu-ray discs to make them look more professional, to keep 
your disc collection more organized, or to add a personal touch to a gift. Disketch makes 
adding your own images and text to disc labels and CD, DVD or Blu-ray covers easy, so that 
you can create your labels and covers quickly. 
Features  

● Create CD, DVD or Blu-ray labels
● Import your own photos to create personalized disc backgrounds and covers
● Print onto commercial sticky labels, or directly onto printable discs. 

See: Printing direct to disc. 
● Harness the power of drag and drop - move and layer text and images to create a label 

masterpiece
● Easily format, resize and align your text
● Import audio track names directly from an audio CD in your disc drive
● Change the background of the disc
● Manually adjust the printing position on each page
● Automatically recover your design project from the previous interruption or crash
System Requirements  
● Windows XP / Vista / 7 / 8 / 10
● Mac OS X 10.4 or later Intel based Mac computer
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Getting Started
When first starting Disketch, you will be greeted by the welcome dialog, where you can select 
to either: 

● Create a new project
● Open an existing project file
● Read the Getting Started guide
Selecting 'Create new project' will open the select label layout dialog. From here you can 

decide which kind of project you wish to create. 
Once you have selected a project type, you will see the main window, where you will spend 
most of your time refining your creations. 
Your work will be automatically saved to help you restore it if there is any interruption or crash 
happened. In these situations, just re-run Disketch, your work will be recovered. Make sure you 
save your autosaved project to your working directory before continue with your creations. 
Note: The editing project is temporarily saved for recovery every minute. 
When you have finished designing your label, click the Print buttons on the main window 
toolbar to bring up the print preview dialog. 
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Main Window Reference
Toolbar 

The main window's toolbar contains useful buttons for frequently occurring operations you 
will be performing. 
The toolbar tabs are used in the following ways: 

The File Tab 
Contains most options for loading, saving, and closing your current project. It also 
contains options for selecting a new label layout, for printing, and for opening the recent 
files list. See: Menu reference for more information on each action. 
The Home Tab  
Contains several of the New, Open, and Save buttons from the File tab, as well as 
buttons for: 

● Adding text overlays
● Adding image overlays
● Adding clipart overlays
● Adding frame overlays
● Copying CD Info. See: Audio CD Details 
● Opening the Print Preview dialog 
● Opening the General Options dialog 
The Edit Tab 

Contains buttons for interacting with overlays and the clipboard, including: 
● Undo, Redo
● Cut, Copy, Paste
● Delete
The Template Paginator 

The template paginator is located directly beneath the toolbar, on the left hand side. The 
template paginator contains tabs indicating the type of available templates in your project's 
label layout. 
It is important to note that if the Use same design for same template types box is checked 
(See: Label layout properties panel) , tabs will update to indicate the type of templates 
available in your project's label layout. 
The Project Viewer  
This is the main window directly beneath the template paginator, where you see a 
representation of your currently selected template. 
This viewer is where text and image overlays  will be added to your project, which you can 
rotate, scale, and position to achieve your label's desired look. 
It is important to note that if you rotate your template via the Label Layout Editor dialog, that 
the project viewer will still display your label layout in an un-rotated state. Opening either the 
Label Layout Editor dialog or the Print Preview dialog will confirm that a given template will 
print correctly rotated. 
Panels 
Several types of panels will appear to the right of the project viewer. These panels contain 
many options for interacting with specific elements of you project, such as the: 

● Label Layout Properties panel. 
● Background Properties panel. 
● Text Overlay Properties panel. 
● Image Overlay Properties panel. 

4

menu.html
concepts_audiocddetails.html
dialogs_printpreview.html
options_general.html
panels_mainwindow.html
concepts_overlays.html
dialogs_labellayoutedit.html
panels_mainwindow.html
panels_mainwindow.html
panels_textoverlay.html
panels_imageoverlay.html


Menu Reference
The menus are hidden from the main interface by default when you install Disketch. To show 
the menus, click the small arrow to the left of the Help icon in the upper right corner of the 
interface.
File Menu 

Open (Ctrl + O) 
Loads an existing Disketch project or an image 
New (Ctrl + N) 
Creates a new Disketch project 
Save (Ctrl + S) 
Saves your Disketch project 
Save As  

● Project (Ctrl + Shift + S) 
Saves your Disketch project as a new file 

● PDF 
Saves the selected template to a PDF file 

● Image 
Saves the selected template to an image file 

Label Layout 
● Select... 

Opens the Select Label Layout dialog 
● Edit... (Ctrl + E) 

Opens the Label Layout Editor dialog 
Print... (Ctrl + P)  

Opens the Print Preview dialog, to print your Disketch project 
Register Software 
Opens the Register Software window where you can enter your registration details, which 
you received after you purchased and activated Disketch. 
Recent files 
A list of your recently opened and saved Disketch projects 
Exit (Alt + F4) 
Closes Disketch 
Edit Menu 
Undo (Ctrl + Z) 
Undo the last operation 
Redo (Ctrl + Y) 
Redo the last undone operation 
Cut (Ctrl + X) 
Copies and deletes the selected overlay 
Copy (Ctrl + C)  
Copies the selected overlay to the clipboard 
Paste (Ctrl + V) 
Pastes information from the clipboard: 

● Disketch data. 
Text, image, clipart or frame overlays, including settings for those overlays 

● Text data. 
Pasting creates a new Text overlay containing the text string 

● Image data. 
Pasting creates a new Image overlay containing the image 
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● Clipart data. 
Pasting creates a new Frame overlay containing the clipart 

● Frame data. 
Pasting creates a new Frame overlay containing the frame 

Delete 
Deletes the selected overlay 
Overlay Menu 
Add Text...  
Adds a Text overlay to the current template 
Add Image(s)...  
Adds an Image overlay to the current template 
Add Clipart...  
Adds a Clipart overlay to the current template 
Add Frame...  
Adds a Frame overlay to the current template 
Copy CD Info...  
Allows you to load CD details to add them to your label. See: Audio CD Details 
Rotate Left 
Rotates the selection counter-clockwise 
Rotate Right  
Rotates the selection clockwise 
Raise (Ctrl + Equals) 
Brings the selection forward by one layer 
Lower (Ctrl + Minus)  
Sends the selection backwards by one layer 
Tools Menu 
Options... 
Opens the program options. See: General options 
Help Menu 
Contains assorted help topics 
Note that you can open the help documentation by pressing F1 on your keyboard 
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Keyboard Shortcuts
The following list shows shortcuts for the most common tasks used in Disketch:
● Open an existing project or an image Ctrl+O
● Create a new project Ctrl+N
● Save your project Ctrl+S
● Save your project as a new file Ctrl+Shift+S
● Edit Label Layout Ctrl+E
● Print Ctrl+P
● Undo Ctrl+Z
● Redo Ctrl+Y
● Cut Ctrl+X
● Copy Ctrl+C
● Paste Ctrl+V
● Delete Delete
● Raise overlay layer Ctrl+Equals
● Lower overlay layer Ctrl+Minus
● Options Ctrl+Shift+O
● Help menu F1
● Exit Disketch Alt + F4
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Command Line Options
You can easily control Disketch from the command line or using the NCH API. The command 
line format is: 
disketch [command] [command_options] ...  
COMMAND: 
-new <label_layout>  
Creates a new project. Valid label layout options are: 
● cd: CD and Case on Generic Paper
● dvd: DVD and Case on Generic Paper
● bluray: Blu-ray Disc and Case on Generic Paper
● direct2disc: Printable CD, DVD or Blu-ray
-open <project_file>  
Opens an existing .deproj/.dex project file. Please enclose the path in double quotes (e.g. 
-open "fullpath"). 
-custom <label_layout_file>  
Opens an existing .delayout layout file. Please enclose the path in double quotes (e.g. -custom 
"fullpath"). 
-addtext <text_file>  
Creates a text overlay from the contents of a text file. Please enclose the path in double quotes 
(e.g. -addtext "fullpath"). 
-addimage <image_file> 
Creates an image overlay from an image file. Please enclose the path in double quotes (e.g. 
-addimage "fullpath"). 
NOTES: 
● Use only one of -new, -open, or -custom commands.
● The -addtext and -addimage commands can each be used multiple times.
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NCH Software Suite
This is a useful way to browse all the software available from NCH Software
You can see a set of products by type like Audio, Video and so on and view the product. From 
there you can try out the product and it will download and install it for you to trial. If you already 
have the product installed then you can click "Run It Now" and the program will be launched for 
you.
There is also a list of features for products in the category. Click on a feature, such as "Edit a 
Video File", to install a product with that ability.
Search  
Search our website for products matching any keywords you type. 
See more of our software  
Browse our website for more software. 
Subscribe to our newsletter 
You can subscribe to our newsletter for announcements of new releases and discounts. You 
can unsubscribe at any time. 
See the latest discounts for purchase  
See the latest discounts we are offering for purchasing our products. 
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Software License Terms
Our goal is for every user to have a successful experience with our software. We offer it to you 
on the basis that you accept our End User License Agreement (EULA).
This EULA limits our liability and is governed by an arbitration agreement and venue 
agreement. Please read below as these terms affect your rights.
1. The copyrights in this software and any visual or audio work distributed with the software 
belong to NCH Software and others listed in the about box. All rights are reserved. Installation 
of this software and any software bundled with or installed-on-demand from this software, 
including shortcuts and start menu folders, is licensed only in accordance with these terms. 
These copyrights do not apply to any creative work made by you, the user.
2. By installing, using or distributing the software you, on your own behalf and on behalf of your 
employer or principal, agree to these terms. If you do not agree to any of these terms, you may 
not use, copy, transmit, distribute, nor install this software - return it to the place of purchase 
within 14 days to receive a full refund.
3. This software, and all accompanying files, data and materials, are distributed "as is" and with 
no warranties of any kind, whether express or implied except as required by law. If you intend 
to rely on this software for critical purposes you must test it fully prior to using it, install 
redundant systems and assume any risk.
4. We will not be liable for any loss arising out of the use of this software including, but not 
limited to, any special, incidental or consequential loss. Your entire remedy against us for all 
claims is limited to receiving a full refund for the amount you paid for the software.
5. You may not use this software in any circumstances where there is any risk that failure of 
this software might result in a physical injury or loss of life. You may not use this software if you 
do not regularly backup your computer, or do not have antivirus and firewall software installed 
on the computer, or keep sensitive data unencrypted on your computer. You agree to 
indemnify us from any claims relating to such use.
6. You may copy or distribute the installation file of this software in its complete unaltered form 
but you may not, under any circumstances, distribute any software registration code for any of 
our programs without written permission. In the event that you do distribute a software 
registration code, you will be liable to pay the full purchase price for each location where the 
unauthorized use occurs.
7. Use of data collected by the software is subject to the NCH Software Privacy Statement 
which allows automatic anonymized collection of usage statistics in limited circumstances.
8. Choice of Law. If you reside in the United States, your relationship is with NCH Software, 
Inc, a United States company, and this agreement is governed by the laws and courts of 
Colorado. If you reside anywhere in the world outside of the United States, your relationship is 
with NCH Software Pty Ltd, an Australian company, and this agreement is governed by the 
laws and courts of the Australian Capital Territory. Such courts have continuing and exclusive 
jurisdiction over any dispute between you and us, regardless of the nature of the dispute.
9. U.S. Customers Only: Arbitration Agreement and Class Action Waiver: PLEASE READ THIS 
CAREFULLY. IT MAY AFFECT YOUR RIGHTS.
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If you reside in the United States, NCH Software and you agree to arbitrate all disputes and 
claims between us. This agreement to arbitrate is intended to be broadly interpreted. 
References to "NCH" "you," and "us" include our respective subsidiaries, affiliates, agents, 
employees, predecessors in interest, successors, and assigns. This arbitration agreement 
does not preclude you from bringing issues to the attention of U.S. federal, state, or local 
agencies. Such agencies can, if the law allows, seek relief against us on your behalf. This 
Agreement evidences a transaction in interstate commerce, and thus the Federal Arbitration 
Act governs the interpretation and enforcement of this provision. This arbitration provision shall 
survive termination of this Agreement.
A party who intends to seek arbitration must first send to the other, by certified mail, a written 
Notice of Dispute ("Notice"). The Notice to NCH should be addressed to:
Legal Department
NCH Software, Inc.
6120 Greenwood Plaza Blvd, Ste 120
Greenwood Village CO, 80111
USA 
("Notice Address"). The Notice must (a) describe the nature and basis of the claim or dispute; 
and (b) set forth the specific relief sought ("Demand"). If NCH and you do not reach an 
agreement to resolve the claim within 30 days after the Notice is received, you or NCH may 
commence an arbitration proceeding. The amount of any settlement offer made by NCH or you 
shall not be disclosed to the arbitrator.
A. The arbitration will be governed by the Commercial Arbitration Rules and the Supplementary 
Procedures for Consumer Related Disputes (collectively, "AAA Rules") of the American 
Arbitration Association ("AAA"), as modified by this Agreement, and will be administered by the 
AAA. The AAA Rules are available online at adr.org, by calling the AAA at 1-800-778-7879, or 
by writing to the Notice Address. The arbitrator is bound by the terms of this Agreement. All 
issues are for the arbitrator to decide, including issues relating to the scope and enforceability 
of the arbitration provision. Unless NCH and you agree otherwise, any arbitration hearings will 
take place in Greenwood Village Colorado. If your claim is for $10,000 or less, we agree that 
you may choose whether the arbitration will be conducted solely on the basis of documents 
submitted to the arbitrator, through a telephonic hearing, or by an in-person hearing as 
established by the AAA Rules. If your claim exceeds $10,000, the right to a hearing will be 
determined by the AAA Rules. Regardless of the manner in which the arbitration is conducted, 
the arbitrator shall issue a reasoned written decision. NCH will pay all AAA filing, 
administration, and arbitrator fees for any arbitration initiated in accordance with the notice 
requirements above. If, however, the arbitrator finds that either the substance of your claim or 
the relief sought in the Demand is frivolous or brought for an improper purpose then the 
payment of all such fees will be governed by the AAA Rules. In such case, you agree to 
reimburse NCH for all monies previously disbursed by it that are otherwise your obligation to 
pay under the AAA Rules. In addition, if you initiate an arbitration in which you seek more than 
$75,000 in damages, the payment of these fees will be governed by the AAA rules.
B. The arbitrator may award declaratory or injunctive relief only in favor of the individual party 
seeking relief and only to the extent necessary to provide relief warranted by that party's 
individual claim. YOU AND NCH AGREE THAT EACH MAY BRING CLAIMS AGAINST THE 
OTHER ONLY IN YOUR OR ITS INDIVIDUAL CAPACITY, AND NOT AS A PLAINTIFF OR 
CLASS MEMBER IN ANY PURPORTED CLASS OR REPRESENTATIVE PROCEEDING. 
Further, unless both you and NCH agree otherwise, the arbitrator may not consolidate more 
than one person's claims, and may not otherwise preside over any form of a representative or 
class proceeding. If this specific provision is found to be unenforceable, then the entirety of this 
arbitration provision shall be null and void.
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C. Notwithstanding any provision in this Agreement to the contrary, we agree that if NCH 
makes any future change to this arbitration provision (other than a change to the Notice 
Address) you may reject any such change by sending us written notice within 30 days of the 
change to the Arbitration Notice Address provided above. By rejecting any future change, you 
are agreeing that you will arbitrate any dispute between us in accordance with the language of 
this provision.
D. To opt out of this Arbitration Agreement and class action waiver send an Opt Out notice to 
the Notice Address stating "I am electing to opt out of the Arbitration Agreement and class 
action waiver contained in the Legal Terms applicable to my purchase of an NCH product." 
Your Opt Out Notice must include the date and proof of purchase. The Opt Out Notice must be 
postmarked no later than thirty (30) days after the date of purchase. A separate Opt Out Notice 
must be sent for each product purchased.
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Concepts - Audio CD Details
Audio CD details  

Disketch can read the contents of a disc in your computer's disc drive and automatically 
retrieve its track list and details from an online database. 
To add the contents of your disc to the label, insert the disc into your CD drive, then click 
one of the three audio details options from the Copy CD Info  button on the Home tab: 

● Album Title 
This will retrieve the title of the audio CD 

● Artist Name 
This will retrieve the name of the artist or band on the CD 

● Track List  
This will retrieve the track numbers of each song, the names of the audio tracks on 
the CD, as well as the duration of each song 

Your selection will be added as a new text overlay to your project. Use the 
Text Overlay Properties panel, which appears when the text is selected on your template, to 
reposition and adjust the formatting. 
Please note that on occasion the database may not find a match to your specific audio CD. 
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Concepts - Label Layouts
A label layout describes how your project is laid out for printing, how each page will be printed, 
and which types of templates you have decided to add to each page. Label layouts are 
displayed on the main interface. To edit a label, click the Edit label layout button in the toolbar 
or right sidebar. 
Each label layout contains of a minimum of one page, and one template of any type. 
Pages 
Each page will be in either a portrait or landscape orientation. 
The default paper size for new projects can be altered in the General Options dialog. The 
paper size of the pages used by your current project can be altered in the 
Label Layout Properties panel, located in the Label Layout Editor dialog. The Label Layout 
Editor dialog is also where you can select label stationery you are printing on. Click the Station
ery  toolbar button to select from the stationery list. 
Note that you are able to print using any page size via the Print Preview dialog. However, 
choosing a size of paper different from the size you have selected for your label layout can 
have poor printing results. 
Templates 
A template is a label of some size and shape determined by the project type you are creating. 
You can add text and image overlays  to any template from the main window, as well as select 
a background for the disc label of your choice. See: Background Properties 
From the Label Layout Editor you are able to position and rotate your templates as required. 
Note that, from here, you are also able to change the printable areas of disc templates via the 
Change Disc Printable Areas dialog. 
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Concepts - Overlays
Overlays are image or text elements placed onto a template in a project from the main window. 
They can be positioned, resized and rotated. 
You can use your mouse to right-click inside the project viewer to present several options for 
overlays. These options will have similar behavior to the Cut, Copy, Paste, and Delete buttons 
found in the edit menu. See: Menu reference 
Text Overlays 

Text overlays each contain text of any length. 
To add text to your label, click the Add Text  button on the main window toolbar. A text 
overlay will appear on your template with the word [Text] in black. Click the text overlay if it 
is not active. You can tell that the text overlay is active when you see a either a solid or a 
dashed black box around it. Once active, you can begin to edit your text via the Text 
Properties panel in the right sidebar. This panel only appears when a text overlay is active. 
See: Text Overlay Properties for information about positioning, rotating and resizing your 
text overlays. You can convert a regular text to a curved text by checking Curved Text box 
which can be found in Text Properties panel. A curved text has the same properties as a 
regular text except that it supports top and bottom alignment only. To convert a curved text 
to a regular text, uncheck the Curved Text box. 
Image Overlays 
Image overlays each contain a single image. If the originally loaded image contains an 
alpha channel, the image overlay will appear transparent. 
To add images to your label, click the Add Image(s)  button on the toolbar and then click 
the Add Image(s) as Overlay. The Select Image(s) window will open. Navigate to and 
select the photo or series of photos that you would like to add, then click the Open button. 
Your new image overlay will appear on your template. See: Image Overlay Properties for 
information about positioning, rotating, and resizing your image overlays. 
Image Background 
You can set an image to be the background of your label. 
To add a background image to your label, select the label and choose option Image in the 
Background Properties panel. Click the Browse image as background  button. The Select 
Background Image(s) window will open. Navigate to and select the image that you would 
like to add, then click the Open button. Your new background will appear on your template. 
The old background if existed will be removed. You can set option for keeping the 
background image's aspect ratio in the Background Options dialog. 
See: Image Overlay Properties for information about positioning, rotating, and resizing your 
image overlays. 
Clipart Overlays 
Clipart overlays each contain a clipart downloaded from NCH Clipart Library. 
To add a clipart to your label, click the Add Clipart button on the toolbar or the menu item 
Add clipart... from Overlay menu. A Clipart dialog will open. Use the panel on the left of the 
dialog to select a clipart category. When a category is selected, a list of clipart images will 
be displayed in the center of the dialog. Click on any image in the list to see a preview on 
the right side of the dialog. When you find a clipart you like, click the Download button. 
Once the image has finished loading, the clipart will be added to the project as a Clipart 
Overlay. See: Image Overlay Properties for information about positioning, rotating, and 
resizing your clipart overlays. 
Frame Overlays 
Frame overlays each contain a frame downloaded from NCH Clipart Library. 
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To add a frame to your label, click the Add Frame button on the toolbar the menu item Add 
frame... from Overlay menu. A Frame dialog will open. Use the panel on the left of the 
dialog to select a frame category. When a category is selected, a list of frame images will be 
displayed in the center of the dialog. Click on any image in the list to see a preview on the 
right side of the dialog. When you find a frame you like, click the Download button. Once the 
image has finished loading, the frame will be added as a Frame Overlay and your label is 
framed by the selected frame. See: Image Overlay Properties for information about 
positioning, rotating, and resizing your frame overlays. 
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Concepts - Printing Direct to Disc
Availability: 

Some newer inkjet printer models support the ability to print directly onto the surface of 
printable disc media. 
There is no international standard for the sizing, positioning, or source for these features, 
each manufacturer does what is most convenient for their product. Since this is the case, 
we are unable to support all models of printers capable of this feature at the present time. 
However, we will continue to add more models in future updates. 
If you find your printer is compatible, please let us know at Suggestions: Disketch If your 
printer is not in the list, you may still be able to print by selecting one of ten general Canon 
printers from the list. First, try to figure out your disk tray type by looking for a character at 
corners of your CD tray. You can then select one corresponding printer from ten general 
Canon printers supporting ten popular tray types: A, B, C, D, E, F, G, H, J and K. 
Method:  
If your printer is capable of printing direct-to-disc, begin by creating a direct-to-disc project 
by selecting the Direct to Disc option when creating a new project. See the 
Dialogs: Select Label Layout  topic in this manual. 
Your direct-to-disc project will only contain a template for the disc label, not for a jewel case 
or cover. 
When you have finished designing your disc label, press the Print button. 
See: Print Preview. 
It is important to note that when you have selected your printer from the print dialog, you 
must select your printer's equivalent of 'printable disc' as the output media, and, if required, 
also select the equivalent of 'disc tray' as the paper source.  
For example, for Canon printers, you need to set the Media Type as "Printable disc 
(recommended)" and the Paper Source as "Disc tray". These setting names can be different 
from printer manufacturers. Please read your printer instructions for setting direct to disc 
printing. 
Table of supported printers for direct-to-disc printing: 

Manufacturer  Printer Model 
Canon  Canon 

● PIXMA i865, i965, i9950, iP3000, iP4000, 
iP4000R, iP4840, iP4200, iP4300, iP4500, 
iP4600, iP4700, iP4800, iP4920, iP5000, 
iP5200R, iP5300, iP6000, iP6000D, iP6600D, 
iP6700D, iP7220, iP7240, iP7250, iP7260, 
iP7420, iP8500

● PIXMA MG5140, MG5240, MG5250, 
MG5350, MG5420, MG6120, MG6140, 
MG6150, MG6300, MG6320, MG6350, 
MG7129, MG7130, MG8120, MG8140, 
MG8150, MG8250, MP500, MP530, MP600, 
MP610, MP630, MP640, MP750, MP760, 
MP780, MP790, MP800, MP810, MP830, 
MP950, MP960, MP970, MP980, MP990, 
MX850

● PRO-1, PRO-10, PRO-100; Pro 9000, 9000 
Mark II, 9500, 9500 Mark II
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● Other Canon printers with tray types A, 
B, C, D, E, F, G, H, J, and K

Seiko Epson  Epson 
● Artisan 50, 700, 710, 720, 725, 800, 810
● EP-301, EP-801A, EP-901A, EP-901F
● PM-870C, PM-890C, PM-900C, PM-920C, 

PM-A820, PM-A840, PM-A840S, PM-A890, 
PM-A900, PM-A920, PM-A940, PM-A950, 
PM-A970, PM-930C, PM-950C, PM-970C, 
PM-980C, PM-4000PX, PM-D750, PM-D770, 
PM-D800, PM-D870, PM-D1000, PM-G700, 
PM-G720, PM-G730, PM-G800, PM-G820, 
PM-G860, PM-G900, PM-G4500, PM-T960, 
PM-T990

● PX700W, PX800FW; PX-5600, PX-G930, 
PX-G920, PX-G5100, PX-G5300

● RX580, RX585, RX610, RX680, RX685, 
RX690, 

● TX700W, TX800FW
● Stylus C60, C86; Stylus Photo 890, 900, 920, 

950, 960, 970, 1390, 1400, 1410, 2100, 
4000PX, P50, PX660, PX720WD, 
PX820FWD, R200, R210, R220, R230, R260, 
R265, R270, R280, R285, R290, R295, R300, 
R300M, R310, R320, R340, R350, R360, 
R380, R390, R800, R1800, R1900, R2000, 
R2100, R2880, R3000, RX560, RX580, 
RX590, RX595, RX615, RX640, RX650, 
RX700, T50, T59, TX650, TX659, TX710W, 

● XP-600, XP-605, XP-610, XP-615, XP-700, 
XP-750, XP-800, XP-810, XP-850, XP-950

● Other Epson printers with tray types 1 and 2

Hewlett Packard  HP 
● C5240, C5250, C5270, C5273, C5275, 

C5280, C5283, C5288, C5290, C5293, 
C5380, C5550, C5580

● D5145, D5155, D5160, D5168, D5360, 
D5363, D5368, D5400, D5460, D5500, 
D7500, D7560

Brother  Brother 
● MFC-j825DW, MFC-j835DW, MFC-j925DW

Primera  Bravo SE 
● AutoPrinter
● Disc Publisher
● Blu Disc Publisher

Imation  Imation 
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● D20 Disc Publisher

Microbards  Microbards 
● G3, GX, MX Disc Publisher

If your printer does not appear in the above list, it may still be capable of direct-to-disc printing 
using Disketch. If you find your printer is compatible, please let us know at 
Suggestions: Disketch 
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Concepts - Printing to Commercial Stationery
Many kinds of commercial stationery are available for purchase. These sticky labels and case 
inserts make it possible to produce labels for your discs that you can't print directly onto. 
Select the model of commercial stationery that you have purchased using the 
Select Label Layout dialog, which is shown when you create a new project, or from the main 
interface by clicking the "Select label layout" button in the right sidebar. From the Select Label 
Layout, select the Select Stationery  option to open the Select Stationery dialog. 
Once you have selected the appropriate label layout for your stationery, continue to make the 
desired changes to the designs that will appear on each template in your project by changing 
the background colors or image, and adding overlays. 
When you have finished customizing your designs, click the Print button on the Home tab 
toolbar. See: Main window  
If your stationery contains more than one page, make sure that you have the page you want to 
print selected in the Label Layout Properties panel. 
If the stationery that you have doesn't appear in the Select Label Layout dialog list, you can 
use the Edit Label Layout  dialog to create your own layout to match the dimensions of your 
stationery. Then, please let us know about the brand, model, and values used to match your 
stationery at Suggestions: Disketch and we will add it to our list. 
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Concepts - Issues with Off-center alignment and 
Unfullfilled-label
Due to the imperfect mechanical precision of printers, it is not always your designed label is 
perfectly printed. The final printed label might not be in the exact center of the disc or cover all 
the whole disc area. 
You can solve these problems by changing the center position of the label or the disc printable 
area. Remember that the errors are usually quite small so be careful when you change the 
center position of the label or the disc printable area. See: The Template Properties Panel  
In Disketch, you can change these parameters at The Template Properties Panel  of the 
Label Layout Editor dialog when you are designing your label or the Print Preview dialog when 
you are pre-printing for the final product. 
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Dialogs - Add Template
This dialog contains a list of templates that can be added to your project via the 
Edit Label Layout Editor  dialog. You can use it to create a custom template for stationery not 
available in Disketch. Open this dialog by clicking the Add Template  button on the toolbar of 
the Edit Label Layout dialog, accessed by clicking the Edit label layout button in the right 
sidebar of the main interface. 
Select a template to add to the currently selected page, and click the Add  button. The new 
template will be added in the center of the currently selected page, which you can now position 
and rotate as desired. 
Note that you are also able to change the printable areas of disc templates via the 
Change Disc Printable Areas dialog (See: Label Layout Editor panels ), which is accessed by 
clicking the Change disc printable areas  button while a template is selected in the editor. 
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Dialogs - Change Disc Printable Areas
Using this dialog, you can define the size of the circular shapes that Disketch prints to. This is 
useful if you would like to print onto printable discs that do not match the dimensions of the 
default printable area set by Disketch. Each brand of printable discs has varying dimensions. 
An example includes full-faced discs, which print almost to the spindle. 
While being displayed and printed in Disketch, disc templates do not print onto the hole in the 
center of the discs. The inner diameter cannot be smaller than the spindle diameter, and the 
outer diameter cannot be larger than the disc diameter. 

1. Outer diameter 

The outer printable diameter describes the outer-most edge of the printable area of your 
disc. 
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Second disc band
If the 'Use second band' checkbox is ticked, values 2 and 3 will create a ring-shaped, 
non-printable band on your disc. 
● 2. Outer band diameter  

Describes the outer edge of the non-printable band. 
● 3. Inner band diameter 

Describes the inner edge of the non-printable band. 
4. Inner diameter  
The inner printable diameter describes the inner-most edge of the printable area of your 
disc. 
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Dialogs - Edit Label Layout
The Edit Label Layout dialog is used for modifying and creating your own label layouts, or 
where your templates are placed on the page. Layouts can be used either for personalized 
label designs, or for matching the dimensions of sticky labels that you have purchased (
See: Printing to Commercial Stationery). 
Edit Label Layout Toolbar  

New 
This will reset the current label layout to one page without templates. You must add at least 
one template to be able to apply this label layout. 
Stationery 
This will launch the Select Stationery dialog, which will create a layout with templates 
already placed to match your sticky labels. 
Import 
This will open a dialog where you can select a previously saved Disketch label layout file 
(*.delayout). 
Export  
This will open a dialog where you can save your label layout design as a Disketch label 
layout file (*.delayout). 
Add Page 
Add a new page to your label layout. Additional pages allow you to keep, for instance, a 
label and a cover within one project. 
Remove Page 
Remove the currently selected page from your label layout. 
Add Template  
This will launch the Add Template dialog, where you can select label and cover templates 
to add to the page. 
Remove Template  
Remove the currently selected template from your label layout. Alternatively, right click on a 
template to delete it from the page viewer. 
Page tabs  
Each tab will change the page viewer to show the corresponding tab. 
Clicking the small X on the tab will remove that page from your label layout. 
Note that this X will not appear if there is only one page, as you must have at least one 
page in a label layout. 
Page viewer  
The page viewer shows a visual representation of your label layout design. Any templates 
that you add to your project can be repositioned by clicking and dragging, or by using the 
positioning controls in the Template Properties panel in the right sidebar, or by using the 
arrow keys. 
Templates in this viewer are displayed with an arrow across their surface. This arrow 
indicates the up direction of that template if it has been rotated in the template properties 
panel. 
If you have any paper margins set, you will see a border area displayed on each page. This 
border will not effect your ability to print or position templates on your label layouts, they are 
only intended to be guides. To set paper margins, See: General Options. 
Panels 
On the right side of the page viewer there are several panels for modifying your label layout 
design. See: Label Layout Editor panels  for detailed descriptions. 
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● Label Layout Properties 
● Page Properties  
● Template Properties 
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Dialogs - Print Preview
The print preview dialog shows what your final project should look like. It also allows you to 
match your final label with the media you use. Open the Print Preview dialog by clicking Print 
from the Home tab toolbar, or select Print from the File tab menu. 
Print Preview  

The print preview dialog shows how your printout will look. 
If you are printing from a label layout with more than one page, only the page currently 
selected in the 'Label layout properties' panel will be displayed in the preview. 
See: Main window panels 
Print Properties panel 

This is the sidebar of the Print Preview window. It includes information about your layout. 
If your project includes a label layout, the following information will be displayed in the Print 
Properties panel: 

Paper size 
The paper size label will display the paper size that your projects label layout has been 
designed to print onto. 
See: Printing to commercial stationery 
Orientation 
The orientation label will display the orientation of the currently selected page that your 
label layout has been designed to print onto. 
Note that you can change the orientation that your printer will output after clicking the 
'Print' button, changing this orientation to an orientation the current page was not 
designed for may have unexpected results. 
Print template outlines 

This check box will toggle if the outlines of templates will be printed after clicking the 'Print' 
button. The print preview will reflect the current state of this control. 
Note: This property is not a template property. 
Template Properties panel 

This is where you can align your label before printing. A small tuning of the center location or 
disc printable area can make your label perfectly match with your specific printers and printing 
media. 
Make sure to select the template you would like to adjust before changing values, especially 
when you are working with stationery. The mouse shape will change to a hand cursor when 
you move over the selected template. 
Print 

The 'Print' button will launch your system's print dialog, where you can select the printer that 
you will be printing to, and any additional properties for this printing process. 
While not necessary, it is recommended that you select properties matching those that your 
label layout or direct-to-disc project were designed for, as choosing different options may 
have unexpected results. 
Defaults 
The 'Defaults' button will restore the original settings of your label template under "Template
Properties" . 
This button is useful when you get lost in changing your label settings before printing. The 
original settings include the centre position and the disc printable area if possible. 
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Dialogs - Select Label Layout
The Select Label Layout dialog will define a new project of you have none open, or change the 
label layout of any current project. Disketch will try to preserve your designs if you select a 
label layout with templates available that are similar to the templates within your current label 
layout, but some work may be lost. 
The Label Layout options are as follows: 
CD and Case on Generic Paper* 

Three pages with one of the following templates centered on each page:
● Standard disc
● Standard CD case - Front
● Standard CD case - Back
*Generic Paper defaults to the paper size you have selected in the General Options 

dialog. 
DVD and Case on Generic Paper* 

Two pages with one of the following templates centered on each page:
● Standard disc
● Standard DVD case
*Generic Paper defaults to the paper size you have selected in the General Options 

dialog. 
Blu-ray Disc and Case on Generic Paper* 

Two pages with one of the following templates centered on each page:
● Standard disc
● Standard Blu-ray case
*Generic Paper defaults to the paper size you have selected in the General Options 

dialog. 
Direct to Disc 

Standard disc. 
See: Printing direct to disc 
Select Stationery  
This will launch the Select Stationery dialog where you can select the commercial sticky 
labels you have purchased. 
Load Custom 
This will open a dialog where you can select a previously saved Disketch label layout file 
(*.delayout) 
See: Label Layout Editor, Export 
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Dialogs - Select Stationery
The Select Stationery dialog lists a range of label layout designs pre-loaded into Disketch that 
the user is able to select. 
Name 
This list contains the list of label layouts available for use in Disketch. Select a label either for 
ease of use, or for matching labels that you may have already purchased. 
See: Printing to Commercial Stationery 
Preview 
This preview allows the user to see the layout of the stationery they have selected from the Na
me  list. If the selected stationery contains more than one page, the user can select the 
desired page to preview from the tabs above the page viewer. 
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Options - General
The Options dialog allows the user to specify certain Disketch customization preferences. The 
tab General  allows you to specify general preferences. 
Show Welcome dialog when Disketch starts 
This checkbox determines if the Welcome to Disketch dialog is shown each time you open 
Disketch. 
Units  
This determines the measurement units used by all controls within Disketch. 
Default Paper Size 
This determines the paper size that label layouts are defaulted to. 
Paper Margin Guides 

These margin guides are used purely for positioning purposes on the Label Layout Editor 
dialog. 
The size of these margins cannot exceed half the size of the selected default page size. 
Note that the distances defined for the paper margin guides will always relate to the paper 
as it appears in a portrait orientation.  
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Options - Background
The Options dialog allows the user to specify certain Disketch customization preferences. The 
tab Background allows you to specify preferences for background images. 
Maintain aspect ratio for background images 
This checkbox determines if the background image size is kept following the original image's 
aspect ratio. Turn this off if you would like to make your background image perfectly fit with 
templates. Turn this on if you would like to keep the image quality. 
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Panels - Main Window Panels
The Label Layout Properties Panel  
This panel serves several useful purposes, including selecting the label layout you want for 
your project, as well as selecting which page will appear when opening the Print Preview 
dialog. 
Buttons are available at the top of this panel to launch both the Select Label Layout dialog, and 
the Edit Label Layout  dialog. 
Beneath these buttons you will find an overview of your project's label layout. Selecting any of 
your label layouts will change the selection in the project viewer. You can click a template to 
display it, or use the arrow buttons to switch between pages of your project (if it has multiple 
pages). 
The final option in the label layout panel is the Use same design for same template types 
checkbox. Checking this box will re-map all templates of the same type in your project, to use 
the same design while printing. The first found template of each type will determine the 
appearance of all the other templates. If you are currently viewing a specific label layout of a 
type which will be re-mapped, its appearance will be used. Any overlays, printable areas 
(See: Label Layouts, Discs), or background colors set on other templates will be lost when 
checking this option. 
Background Properties Panel 
In this panel you will find a color picker control and an background image selector, used for 
selecting the background color or image that will be used by the currently selected template.
You can fill background of the selected template by a solid color, a gradient brush or an image. 
If you don't want to fill the background, just click on No Fill option.
Two types of gradient brush are supported: Linear Gradient and Radial Gradient. They can be 
chosen from the pull down control nearby the Gradient option. Using these gradient brushes 
requires you to set direction of gradient in the square box and stop points in the bar nearby. 
Each stop point is represented by a small triangle. The selected stop point is highlighted with 
yellow color. You can set color of the selected stop point by clicking on the color box nearby 
"Stop Point:" text. You can also add or delete stop points. A new stop point is added when you 
click on the stop point bar at corresponding position. There is a X button for deleting the 
selected stop point.
Text Properties Panel  
See: Text Overlay Properties 
Image Properties Panel 
See: Image Overlay Properties 
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Panels - Text Properties
Text Properties Panel  
The Text Properties panel allows you to modify the selected text on your template. 

Font 
This pull down will display a selection of fonts current available on your system that can be 
applied to the selected text overlay. 
Bold, Italic and Underline  
Clicking these buttons will apply the typical bold, italic and underline font styles to the 
selected text overlay. 
Text color 
Clicking the colored box on the right will open a dialog where you can select the color the 
for the text. 
Background color  
Clicking the colored box on the right will open a dialog where you can select the background 
color for the selected text overlay. This color will fill the area within the draggable border of 
the text overlay. 
Note that the background color will only be drawn if the check box beside the Background 
color label is ticked. 
Text alignment buttons  
Clicking any of these buttons will shift the alignment of the text within the overlay to align to 
the corner/side of the overlay's draggable border, corresponding to the direction of the 
arrow on the button. Similarly, clicking the center button will align the text to the center of 
the text overlay. 
Note that rotating the overlay will not have any effect on how these alignment buttons work. 
Clicking the top alignment button will always align the text to the visual top of the draggable 
border, etc. Note that curved text supports top and bottom alignments only.  
Edit text field 
You can type text into this field in a similar manner to how you would type into any text 
editing program. You can select, cut, copy, and paste. The text that is entered here will be 
displayed within the draggable borders of the text overlay on your template. 
Curved Text  
Convert the selected text from regular format to curved format and vice versa by checking 
or unchecking the Curved Text box. Note: This feature can only be enabled in the "Standard 
disc". 
Rotate, Raise and Lower 
The Rotate left, Rotate right, Raise selection, and Lower selection buttons will behave 
similarly to those in the Overlay menu. 
See: Menu reference 
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Panels - Image Overlay Properties
Image Properties Panel 
This panel contains a label, identifying the image that is currently selected. 

This label is usually set to the original file name the image was loaded from. However it can 
indicate other sources, such the original source being pasted via the clipboard. 
The 'Maintain aspect ratio' check box controls the behavior that resizing this image overlay 

will have inside the project viewer. 
When this checkbox is un-ticked you can freely drag each side of your image overlay to the 
size you require. However while ticked, the aspect ratio of the originally loaded image will 
be used to constrain resizing. 
Rotate, Flip, Raise and Lower 

The rotate left, rotate right, raise, and lower buttons will behave similarly to those in the 
'Overlay menu'. The flip horizontal, flip vertical buttons will flip the selected image overlay 
accordingly. 
See: Menu reference 
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Panels - Label Layout Editor Panels
The Label Layout Properties Panel  
This panel contains a label describing the current name of your label layout, as well as a 
control for changing the paper size that this label layout will use. The name of your label layout 
will change if you export your design, or import a design with a different name. To change the 
default paper size used by label layouts you create, See: General Options. 
The Page Properties Panel 
This panel contains two buttons for choosing the orientation of the currently selected page. 
Your pages can be set to either Portrait, or Landscape orientations. 
The Template Properties Panel  

The template properties panel allows you to very accurately position your templates on 
each page of your label layout. 
A label will display the type of the currently selected template. Beneath this label is a button 
which will launch the Change Disc Printable Areas dialog if your selection is of a disc type. 
The image bellow indicates how the controls within the template properties panel will effect 
the position of your template. 

Note that rotating your page to either portrait or 
landscape orientation, or rotating your template in any direction, will not effect how these 
values are calculated. The 'top' always refers to the 'top' of the page you see visually, the 
'left' refers to the visual 'left' and so on...  
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Center X / Y
The center x and y controls will determine the distance from the top-left of the page in its 
current rotation, to the center of your currently selected template. 
The distance from the top of the page to point 1  for center x, and the left of the page to 
point 1  for center y. 
Edge positions  
The edge position controls are used for positioning your template relative to the edges of 
your page in their current rotation. 

● Top  
This is the distance from the top of the page to the top edge of your template in its 
current rotation. The distance indicated by line 2  

● Left  
This is the distance from the left of the page to the left edge of your template in its 
current rotation. The distance indicated by line 3  

● Right 
This is the distance from the right of the page to the right edge of your template in 
its current rotation. The distance indicated by line 4  

● Bottom 
This is the distance from the bottom of the page to the bottom edge of your 
template in its current rotation. The distance indicated by line 5  

Alignment buttons  
Each of the alignment buttons will move your selected template to the corner of the page 
indicated by the arrow direction indicated on the button. The center button will also move 
your template to the center of your page. 
Rotate, Raise and Lower 
The rotate left, rotate right, raise, and lower buttons will behave similarly to those in the 
'Overlay menu'. 
See: Menu reference 
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